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Chapter 1 
Understanding TMA 

Introduction to the Guide 
The TMA Basics Guide gives you an overview of standard conventions 
and how to use the basic functions of the TMA software. 

If you are new to TMA software, this Basics Guide identifies the menus, 
commands, and conventions.  

The chapters include instruction on: 
• creating a basic work order  
• posting labor  
• closing the work order  

Detailed information and instructions for all TMA functions are provided 
in the TMA User's Guide. 

For those familiar with TMA software, this Basics Guide offers a quick 
reference for fundamental tasks. 

The TMA Basics Guide has been written with the assumption that TMA 
Administrator and System setups have been completed.  

Since the TMA software is a database application, a short review of 
database concepts and definitions follows. 

What is a Database? 
A database is a collection of one or more lists or Tables of information.  

Many operations we use daily are based on database applications, for 
example: 

• automatic tellers at the bank 
• supermarket checkout 
• airline reservations 

Databases are made up of Tables, Records, and Fields. 

Database Tables 
The TMA software has many Tables (lists of information), such as: 

• buildings 
• rooms 
• technicians 
• warehouse inventory 
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When work orders are added to the system, they are actually added to a 
list of information or Table. 

Database Records 
Database Tables are composed of Records. Records are one of many line 
items within a database Table. For example, the TMA Parts Table 
contains many records. Each record contains detailed information about 
the individual parts that are kept in inventory. 

Database Fields 
Each Record (item) in a Table (list) requires different types of details. 
The details are called Fields. Certain Fields are required for each Table. 
For example, a Table that lists rooms will require the room number, 
building name, room type, and description. 

Database Functions 

  
 

A database application like TMA performs many different types of 
Functions, which affect the information stored in the database Tables. 
Database Functions usually do one of three things: 

1. Add a new Record to a Table. For example, creating a work 
order adds a new work order record to the TMA Work Order 
Table. 

2. Change one or more fields in an existing record. For example, 
when parts are issued, a transaction called an On-hand 
Adjustment changes the value of the Qty OH for that Part 
Record in the Part Table. 

3. Search, find, and summarize information. Data contained in the 
TMA Tables can be summarized in an on-screen or printed 
report. 

Summary 
TMA is a database application that consists of Tables and Functions. The 
Functions add or change the values in the Tables. Examples of some of 
the TMA Tables include: 

Facility 
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Building 
Equipment 
Vehicles 

Some of the Functions performed by TMA software include: 
• Adding, editing or deleting existing Records in a Table 
• Scheduling a work order using the Scheduler 
• Entering an On-hand Adjustment 
• Adjusting the price of a part 
• Running a report that lists a history of completed work orders 

for an Area 
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Chapter 2 
Basic Navigation 

Login 
A shortcut icon is usually installed on the desktop to launch the TMA 
application. If you do not have a TMA icon or have not been given 
instructions on how to launch the software, contact your TMA System 
Administrator.  

If you have the icon on your desktop, double-click the icon to launch 
TMA software. Depending on the type of connection your TMA System 
Administrator has selected, you may be asked to enter an ID and 
Password. 

The term ‘user’ in TMA documents refers to the person who is logged in 
to the TMA software. The TMA System Administrator sets up user 
records and assigns each user a specific level of access. 

All transactions, including adding or editing records, are registered under 
the current user’s ID. If a user logs in to a workstation and does not log 
off, all transactions made by other users from that workstation are 
attributed to the original user. 

 If a user fails to log out of the system, anyone can use the 
workstation and operate the software with the same level of access as 
the user currently logged in. 

Login Messages 
When logging in, you may receive error messages. If so, contact your 
TMA System Administrator for further assistance.  

Getting Around in TMA 
The TMA home window is visible after a successful login. Each element 
of the home window is defined below.  
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TMA Home Window 

 

Title Bar 
The Title Bar identifies your facility name and the software version.  

Main Menu 
The Main Menu provides access to every menu and submenu within the 
TMA software. Click any enabled (darkened) word to display a menu of 
related functions. See Appendix A for descriptions of each function 
accessed from the Main Menu.  

Keyboard shortcut equivalents are available for most menu items and 
functions and are defined in Appendix B. In general, you can press the 
Ctrl Key and the underlined character (Windows) or Option and the 
underlined character (Macintosh) for main menus or Ctrl+Shift+ the 
underlined character for submenu items (Ctrl+Options for Macintosh).  

TMA Toolbar 
The TMA toolbar is used to locate records as well as Add, Edit, OK (save) 
changes, and Cancel changes.  

You can adjust the size of the toolbar in TMA. The small size eliminates 
the toolbar text and displays only the function buttons. To display the 
toolbar text, select File > Preferences > User Preferences / User 
Interface Elements, and click the Show Toolbar Text check box, or right-
click on the TMA toolbar for the Toolbar Options context menu. 

 

Buttons on the toolbar are grouped in sections that apply to 
adding/editing records, locating records, and task management.  
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Adding / Editing 
Click Add on the TMA toolbar to start a new record or transaction from a 
record window. Type information in the blank fields on a window, and 
click OK to Add and Save a record.  

Click Edit on the TMA toolbar to place the record in Edit mode and 
modify the existing record. 

Delete on the TMA toolbar is sometimes used to remove a record from 
the database. Because of the intricate database connections, only 
records that are not connected to other records can be deleted. 

Locating Records 
Click First, Previous, Find, Next, and Last on the TMA toolbar to locate 
particular records from a record window.  

Find locates a particular record. To use this feature, you must have a 
specific record identifier (for example, a work order number). See the 
topic titled Locating Records with the Toolbar Find Button. 

Next and Previous display the next record in sequence either before or 
after the record currently displayed.  

First and Last display the first or last record entered. 

Task Management 
Click Help on the TMA toolbar for access to information related to the 
open window.  

Click Print on the TMA toolbar to print the displayed record and choose 
any available reporting options. 

Click Cancel on the TMA toolbar to exit Add or Edit mode without saving 
the entries or changes made to the record. 

• Esc is the keyboard equivalent of the Cancel button in MS 
Windows.  

• Command +. (Period) is the keyboard equivalent of the Cancel 
button for the Macintosh. 

Click OK to save the entries or the changes made to the record and 
leave Add or Edit mode. The Enter Key is the keyboard equivalent of the 
OK button. 

TMA Wallpaper 
Click File > Preferences > User Preferences / User Interface Elements 
and click the Show Wallpaper check box to display or hide wallpaper.  

TMA Navigation Bar 
The Navigation Bar on the left side of the TMA home window provides 
quick access to TMA software functions. These icons correspond to 
frequently used selections on the main menu.  

Click the menu names at the bottom of the TMA Navigation Bar to view 
function icons associated with that menu. Click an icon to launch the 
function window. Icons are available based on the user’s privileges. If 
the user does not have access to a function, the icon for that function 
will not appear on the Navigation Bar.  
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The optional Teach Me! menu title bar contains icons for tutorials. 
Updated copies of the tutorials are also available from 
http://www.tmasystems.net. For a complete description, see the topic 
TMA Teach Me! 

 The Navigation Bar is convenient, but the Main Menu is the 
recommended route to review every aspect of the TMA software. 

TMA Window Tour 

 

Window name The name of the selected function.  

Folder Tabs Tabs that open windows containing optional 
fields of information related to the window. 
Click a folder Tab for access to the window. 

Field names Assigned name for a field that occurs in 
every record in the selected window. Some 
field names can be changed by the TMA 
System Administrator. 

Linked 
Documents 
button 

Access point for a list of user-defined files 
that can be linked to the associated window. 

Other 
Functions 
button 

Access point for a list of submenus with 
information and functions related to the 
window. 

Subtabs  Access points at the bottom of the window 
for information and history related to the 
window. Not all windows include Subtabs. 

Subtab Pane Display area for each Subtab. 
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Viewing Tab Windows 
Most windows have multiple folder Tabs. Each Tab window contains 
fields for additional information and options that pertain to a record. To 
move from one to another, click the Tab.  

 Keyboard shortcut: Ctrl+Tab (Windows) or Command+Tab 
(Macintosh). This opens Subtab panes as well as upper Tab windows. 

Moving From Field to Field 
Press the Tab Key to move the cursor from one field to another. To 
move in reverse order, hold down the Shift Key and press the Tab Key.  

 TMA software uses the Enter Key to save the current record and 
change to View mode. 

View, Edit, or Add Mode 
The terms View, Edit, and Add mode are used when referring to a 
window status.  

View mode. The window is available for viewing only – you cannot click 
in a field or tab from field to field to add or modify information. Right-
click functions are available in View mode, but the Cancel and OK 
buttons on the TMA toolbar are unavailable.  

Edit mode. When you click Edit on the TMA toolbar, only Cancel and OK 
are available. You can click in most of the fields to modify the record. 
Click Cancel to exit the record without saving any editing changes. Click 
OK to save the record with changes. 

Add mode. When you click Add on the TMA toolbar, a new record 
window opens. Create a new record by adding information to the fields. 
Only Cancel and OK are available for selection. Click Cancel to exit the 
record without saving entries. Click OK to save the record as entered. 

Time Saving Functions 
The following functions are used to accelerate data entry when locating 
records or editing data: 

• Find 
• Browse 
• Model Records 

Locating Records with the Toolbar Find Button 
When using Find on the TMA toolbar, the search focuses on a particular 
field within a record.  

To locate a particular record: 

1. Open the desired window such as Work Order. 
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2. Click Find on the TMA toolbar. 

3. Click the search field such as Work Order #. 

4. Type the specific information concerning the record being 
sought.  

5. Click OK on the TMA toolbar. 

If a record matches the criteria, it is displayed. 
 

 When using Find, you can identify an indexed field because the 
mouse pointer changes to an ‘I’ beam. 

Locating Records Using the Browse Tab 
Browse is a means of displaying a list of the records in a Table. You can 
view records in groups of varying sizes.  

Use caution before choosing more than a few hundred at a time. If you 
have many records, loading a large list can take time. 

 

Double-click a line to view the full record on the Identity Tab and close 
the Browse window. 

The number of records in the available list is indicated by the red 
number at the lower right corner of the window. 
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Sorting Lists 

 
Both selection popup lists and Browse Tabs support columnar sorting. 
The column with an Up or Down arrow indicates the primary sort column 
and the direction of the sort. A Down arrow indicates a descending sort 
(A-Z), and an Up arrow means an ascending sort (Z-A).  

When you first open the window, the first column displays an ascending 
sort by default. No Up or Down arrow is shown. Once you click a column, 
the arrow is displayed to identify it as the sort column. 

Using Drag-and-Drop with Selection Lists 
Use the drag-and-drop technique to populate fields from the lists in the 
selection windows:  

1. Click to select a line in the list.  

2. Click and hold the mouse button. 

3. Drag your selection into the field or list.  

4. Release the mouse button to populate the field/list with the 
selection. 

Using Auto Find and Wildcards with Selection Lists 
To use Auto Find in Add or Edit mode:  

1. Enter the first few characters in a field.  

2. Press the Tab Key. 

The software automatically populates the field with the closest match to 
the characters typed.  

For example, typing “Red” in the Building field and pressing the Tab Key 
could locate Redwood Office Park. 

To use the asterisk ( * ) as a wildcard in an Auto Find on the first 
column of a selection list: 

1. Press the asterisk key on the numeric key pad (do not use the 
number line above the alpha keys). 

2. Type the first few characters of the record you want to find.  

3. Press the Tab Key.  

The software finds the first record with the closest match.  

Press the Backspace Key to reset a search.  
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Adding Records Using the Model Records Feature 
Model records save time when entering consecutive records that have 
identical or similar settings.  

1. Locate the record that you wish to model. 

2. Click the Model records check box on the Identity Tab. 

3. Click Add on the TMA toolbar. Some of the data from the 
selected record are retained in a new record, instead of the 
usual empty record.  

4. Edit fields as required. (Some fields do not allow duplicate 
data.) 

5. Click OK on the TMA toolbar to save the record. 

Asterisk Indicator 

Linked Documents. An asterisk ( * ) automatically displays next to the 
Linked Documents button when files are linked to a record. The asterisk 
indicates that additional information is available.  

Estimates. An asterisk indicates that an estimate has been completed 
and saved in the Advanced Estimates window (WorkGroup and 
Enterprise only). 

TotalView  
TotalView is a tree list accessed from the File menu or by pressing the 
F4 function key. It is somewhat like a table of contents or directory. It 
displays the data structure of the TMA software.  

 

There are seven initial Views to open: 
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Location View Click the plus sign to expand the tree from 
Facility, to Building or Entity to Area and 
items. 

Item View Click the plus sign to expand the tree from 
any type of item to specific items.  

 You can only zoom to the Equipment Type 
categories linked to your repair center (if 
Equipment Types are linked to a specific 
repair center). This is true regardless of the 
repair center designated for the individual 
equipment items. 

HR View Click the plus sign to expand the tree from 
Shop, to Trade to individual Technician. 

Materials View Click the plus sign to expand the tree from 
Warehouse or Part Types to Parts records. 

Project View Click the plus sign to expand the tree from 
Project Type to Project, Project Tasks, 
Requisitions and Work Orders. 

Utility View Click the plus sign to expand the tree to the 
Facility or Utility. Right-click on an icon for 
context menu options. These vary 
depending on the item.  

Department 
View 

Click the plus sign to expand the tree to 
view the various Departments and related 
Items. Right-click an icon for context menu 
options. These vary depending on the 
Department. 

Right-click an icon in TotalView for related options:  

• Zoom (to record)  

• History (of work)  

• Send Email (to technician) 

• Create a work order 

Click the minus sign to close a cascade list from one of the views.  

Access for TotalView is set from Admin > Security > Users / Privileges 
Tab – File-TotalView check box. Zoom access to connected records via 
TotalView is restricted by repair center access and regulated by normal 
User Privilege controls. 

The Asset and Tools functions are only available in WorkGroup 
and Enterprise versions. 

Common Features and Functions 
Some features and functions are common to most windows in the TMA 
software.  
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Required Fields 
Each record window contains one or more required field(s) that must be 
completed before the record can be saved. If you attempt to save before 
completing all required fields, the software is designed to highlight these 
fields in red.  

Click the highlighted fields, and add the information. Once all the 
required fields are complete, you can save the record. 

 If the TMA System Administrator selects the Color required fields 
option, required fields are color-highlighted when you click Add on the 
TMA Toolbar. 

Using Selection Windows 
Selection windows are used to provide a list of available options for a 
field. Fields that contain selection windows are identified with a down 
arrow button at the right side of the field. Click the down arrow to open 
the selection window.  

 

If the selection window contains more than one section:  

1. Select a line in the left pane of the window to limit the choices 
in the right pane and refine the search.  

2. Click the Building Subtab of the right pane to view buildings or 
the Entity Subtab to view associated entities. 

3. Double-click the line item in the right pane to make the final 
selection and populate the field. 

This selection populates 
the Building field with 
the Building Name 
Autumn Oaks Building 
which is associated with 
the Taft - Main Campus 
Facility. 

 
Selection Window 
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Adding Records 
1. Click the Main Menu or Navigation icon to open the window for 

the new record.  

2. Click Add on the TMA toolbar. This places the cursor in the first 
field of the window. 

3. Type or select the information. A down arrow indicates that a 
selection window is available to assist with choosing the correct 
entry if fields are linked to other files.  

4. Press the Tab Key to move to the next field (or place your 
cursor in the field). 

5. Type the information.  

6. Press the Enter Key or click OK on the TMA toolbar to save the 
record.  

 Some fields are required and must be completed to save the 
record. Not every field must be completed when adding a new record. 
An option in Organization > Repair Center > Records / Preferences is 
available to color-highlight required fields when you click Add. 

Editing Records 
1. Open the desired function window.  

2. Locate the specific record. 

3. Click Edit on the TMA toolbar. The cursor is automatically 
positioned in the first editable field. 

4. Modify the desired fields.  

5. Use the Tab Key to move from field to field, or click in the field 
you want to edit. 

6. Click OK on the TMA toolbar to save the revisions.  

Deleting Records 
1. Open the desired function window.  

2. Locate the specific record. 

3. Click Delete on the TMA toolbar. If the record is linked to other 
records, a message indicates that you cannot delete the record.  

 If there are no links or history affected, a prompt asks you to 
confirm deletion. 

4. Click Yes to delete the record. 

 On many windows in the TMA software you see an Active check 
box. On new records, this check box is marked by default. Since most 
records cannot be deleted because of links or history, they can be made 
inactive to remove them from lists and reports. In Add or Edit mode, 
click the box to clear it and make the record inactive.  
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Right-Click (Option Click for Macintosh) 
Numerous shortcuts are embedded in TMA software; they are accessed 
by a right-click (Option+click for the Macintosh).  

In addition to right-click context menus, many fields feature the right-
click. For example: 

• Work Order – Location ID or Tag Number field for zoom and 
reporting options. 

• Work Order – Almost any field or check box related to batch 
print, browse, create confirmations, and individual billing 
options on any of the Tabs. 

• Work Order Browse – Any line to assign technicians. 

• Building Record – Facility field for zoom to the facility record 
or building history report. 

• Area Record – Building field for zoom to the building record or 
area history report. On the Subtab pane, right-click an item in 
the list to create a work order or access the Model Records 
function. 

• Location ID Field – Area, equipment, asset, vehicle, group, 
tool, and entity to create a work order from the record window. 

• Tag No. Field – Equipment, asset, vehicle, tool, group to 
create a work order from the record window. 

Other areas also use a right-click to access hidden options. If in doubt, 
give it a try. 

Using Date Shortcuts 
To include date information in TMA software:  

• Day/Month shortcut – for dates in the current year, type the 
month and day, for example 0708 for July 8. Be sure to include 
the leading zeros for single digit days and months. If you use 
the European date format (day/month), use the day/month 
sequence. In the previous example, 0807. 

• Day shortcut – for days in the current month, type the day 
(numerical), and tab out of the field. No leading zeros are 
needed with this option. When you tab out of the field, TMA 
completes the full date. 

• Calendar date look-up – click the down arrow to open the 
calendar window. Double-click the day on the desired 
month/year to select the date from the calendar page. 

Cut, Copy, and Paste 
TMA software supports the Microsoft Windows standard cut, copy, and 
paste of text to and from fields in the application.  

Linked Documents 
Click the Linked Documents button to access and create links between 
the TMA window and other files such as spreadsheets, graphics, 
documents, etc. created with external applications. Files are launched 
from the Linked Documents window in the correct application with full 
editing and formatting functionality.  
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 The application used to create the selected file must be installed 
on or available to the TMA workstation in order to launch a file using the 
Linked Documents button. 

Creating a Document Link 
1. Locate the record you want to link. 

2. Click the Linked Documents button. 

3. Click Add on the TMA toolbar when the Linked Documents 
window opens. 

4. Type information in the three required fields: 

 Name: Type a name to identify the link. The name entered 
here does not have to match the actual file name. 

 Path: This is the path to the file. TMA software cannot launch 
the file unless the path and file name are valid. Click the Path 
button to open the Select Import File window and browse for 
the file; double-click the file name to load the path. 

 Type: Select a File Type. These categories are specific to your 
business needs. If the desired File Type has not yet been 
established, it can be created ‘on-the-fly’ from the Document 
Types List window. At least one Type must exist for this window 
to display. 

4. (Optional) Use the selection list to choose from a predefined set 
of Applications. This identifies the program associated with the 
file.  

5. (Optional) Locate the correct program 

6. (Optional) Double-click to select. The field is for information 
only, but specifying an application helps other users locate the 
appropriate file. 

7. Click OK on the TMA toolbar to save the link. The linked 
document Name and Type is shown in the read-only section of 
the window.  

8. Repeat steps 2-7 to create additional links to other files. 

An asterisk is displayed next to the Linked Documents button on the 
Identity Tab if a record has Linked Documents. 

Viewing an Existing Linked Document 
1. Click the Linked Documents button. 

2. Double-click the line item in the list of linked files to launch the 
non-TMA application and the file.  

 You can modify the file if you do not have another copy of 
the non-TMA application open.  

3. Save the modified file with a new name. After saving, this new 
file must be linked using the steps outlined in Creating a 
Document Link above. 

If you purchased the TMA CAFM option, you can view the file with CAFM 
by clicking the View Document with TMA CAFM button. Once launched, 
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the file displays in a window over the linked record. Reposition the 
window as needed for optimal viewing. 

Viewing tools and options are available for use with the file from within 
the CAFM Module as well. For AutoCAD drawings, menus and tools are 
visible on the window to perform many drawing functions such as Zoom 
Extents and Leader Notes. 

Information about Editing and Deleting Document Links is found in the 
“Standard Functions” chapter of the TMA User Guide. 

 Files launched in other applications (such as Microsoft Word or 
Excel) are not released until the current TMA function window, i.e., 
Work Order, Vendors, Equipment, etc., is closed. 

Other Functions Button 
A list of submenus that offer additional information and reports related 
to the item record is visible when you click the Other Functions button 
on a record. Specific details about features on the submenu can be 
found in the “Standard Functions” chapter of the TMA User Guide.  

Subtabs  
Detailed information specific to the open record is displayed on the 
Subtab panes. Subtabs vary with the item being viewed. The Subtab 
panes for each window containing this feature are described in the TMA 
User Guide.  

Report Options 
Click Print on the TMA toolbar to see options for various reports 
including record lists and detail sheets to view or print. These reports 
vary depending on the window. 

Printing 
The software offers to print a work order when you click OK to save the 
record if your repair center has the option Prompt for print selected.  

You can click Print on the TMA toolbar if you do not receive a prompt to 
print.  

The Report Destination window displays several options: 
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• Printer: The work order prints to your system default printer. 

• Screen: A copy of the work order displays on your monitor with 
an icon on the title bar to send to the printer. 

Double-click your destination preference. (Other print options are 
described in the TMA User Guide.) 

Help Functions 
The TMA software provides help on several levels from broad to specific.  

Field Help Message 
The field help message gives you indispensable online help and 
information about a specific field. This feature is cursor sensitive. Move 
the cursor over a field and watch for a "popup" help message related to 
that field. You can use the technique on fields, check boxes, or radio 
buttons. Descriptive information regarding their operation, 
requirements, or purpose is displayed.  

On-Line Help 
Select Help > TMA Help from the Main Menu for the TMA User's Guide. 
The entire manual is available online with full contents, index, and 
search capabilities available.  

TMA Teach Me! 
Brief audio-visual tutorials of some of the primary TMA software 
functions are available if installed from the TMA installation CD. Click 
Teach Me! on the TMA Navigation bar, then click one of the icons to start 
a .wmv tutorial of the related TMA software function.  

Tutorial files are launched in the Windows Media Player and should be 
viewed in full screen to prevent distortion. Note that Windows Media 
Viewer is the only application that will play .wmv files.  

Updated copies of the tutorials are also available from 
http://www.tmasystems.net. After you log in, click the Download link in 
the On-Line Tutorials paragraph. When you click a .wmv file name, it is 
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launched. You may need to set different options in Internet Explorer so 
you can choose Windows Media Player as the viewer and set it to full 
screen. 

Exiting TMA 
Exit the TMA software using File > Quit at the end of operations. Failure 
to exit properly can cause serious problems.  

Closing the Program 
Always close TMA software before you leave for the day, and be certain 
to the use the File > Quit command to do this. Daily backup of data is 
usually made after regular business hours, but the backup may fail if 
any users are logged in when the operation is performed. 

If a user is logged in during records processing, data can be lost or 
corrupted. Data corruption is not immediately detected and may be 
compounded with additional data transactions. 

If TMA Locks Up 
Contact your TMA System Administrator immediately if the TMA 
software locks up, e.g., you cannot enter data or exit the current 
window during the processing of records. In the interim, try the 
following keyboard options in the order listed to attempt to remedy the 
problem:  

1. Press the Esc (Escape) Key on your keyboard. 

2. Press Ctrl + Break 

3. Press Ctrl + Alt + Delete 

Be prepared to tell the TMA System Administrator exactly what actions 
you were taking—in detail—when the system shut down or locked up. 
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Chapter 3 
Creating a Basic Work Order 

Overview 
Work orders form the heart of TMA transactions. When a request is 
received for a maintenance task or when planned maintenance is due, a 
work order is created using TMA software.  

Using information included in the work order windows, you can track: 
• Labor costs 
• Material costs and other charges 
• Payments received 
• Billing information 
• Safety and risk factors 

 

Creating a Basic Work Order – Required Fields 
Path: Transactions > Work Order > Records / Identity Tab 

All that's needed to create a new a work order is data in the required 
fields. (This assumes that the System Administrator has set up the 
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Lookups records that are related to the required fields of the Work Order 
window.) 

Required fields for the Work Order and the associated record are: 
 

Field Name Description Related Records 
Location ID Combination of 

Building Code and 
Area number 

Building and Area  

Building  Location (hierarchy 
level 2) 

Building 
(Organization > Building) 

Area   Location  
 (hierarchy level 3) 

Area 
(Organization > Area) 

Task  Defines what needs 
to be done 

Task Library 
(Organization > Task) 

Trade  Identifies the Trade 
that will perform the 
work 

Trade 
(Organization > Lookups) 

Work order numbers are assigned by TMA when all required fields are 
completed and the record is saved, that is, when you click OK on the 
TMA toolbar. 

How to Create a Work Order 
Path: Transactions > Work Order > Records / Identity Tab 

1. Open the Work Order window. You can do this in several ways, 
such as, click the icon on the Navigation Bar, follow the menu 
path, or use the keyboard shortcuts Ctrl+M (Windows) or 
Command+M (Macintosh). 

2. Click Add on the TMA toolbar. Required fields may show a color-
highlighted background until they contain data. This option is 
selected for your repair center by the TMA System 
Administrator.  

3. Type the Location ID, or if you don’t know the ID, tab out and 
complete the Building and Area fields.  

4. Type or select the Building. If the Location ID field was 
completed, this field is populated automatically. 

5. Type or select the Area number.  

 If you use a selection window, you can double-click to transfer 
information to the field. The Location ID field is also populated 
if previously left blank. If the Location ID field has been 
completed, the Area field is populated automatically. 

6. The Date/Time, Priority, Repair Center, Type, and Charge fields 
are completed by default, but you can make changes. Select 
(highlight) the information in these fields to type your changes, 
or click the down arrow to choose different data. 

 Date/Time defaults to the date of the system clock and initiates 
the elapsed time displayed on the Results Tab. 

 Priority defines the urgency of the work order compared to 
other scheduled work. 

 Repair Center is that of the user logged into TMA. 
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 Type refers to the category of the work order, such as a PM 
work order or a safety-related work order, etc. 

 Charge indicates whether or not the work will be billed to 
another department. The default is NO or YES, depending on a 
selection in your Repair Center / Preferences.  

7. Type or select a Task Code. If you choose from the Task 
Selection Window, use of the Add Task Type or Code buttons is 
restricted. 

 
8. Type or select a Trade. Some task types are linked to a trade. 

If a trade is associated with the task, the Trade field is 
completed by default. 

 

9. Double-click the desired Trade on the popup window.  

Use the Trades Subtab to add additional trades. When more 
than one trade is selected, the work order is called a multi-
trade work order. (See the TMA User Guide for more 
information on multi-trade work orders.) 

 Additional information about the requested work can be added 
in the Request field and is printed on the work order. 

10. Click OK on the TMA toolbar to save.  
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If prompted to print the work order, follow your company’s policy and 
click Yes or No. 

Creating a Basic Work Order – Elective Fields 
Path: Transactions > Work Order > Records / Identity Tab 

It is best to complete as many of the optional fields as possible. 
Information in these fields is useful for follow-up work. 

Requester - The name of the person who made the request. 

Ph - The phone number of the requester. 

Acct # - The account number to be charged (if the work order is 
chargeable). 

Item # (Equipment#, Asset#, etc.) – The ID of a hard asset. 
Hard assets (e.g., equipment, vehicle, etc.) have an 
identification number. A blank Item # field indicates this is a 
work order for the identified space rather than for a specific 
item.  

 Change the dynamic label by clicking the down arrow adjacent 
to the label and selecting from the context menu: 
  

 Click the down arrow at the right side of the field for selections 
of item # and type. (See the topic Using the Item Selection 
Window for details.) 

Reference # – The number that is converted from the request log. 
If a work order is converted from a request, this field contains 
the request number. If blank, this alphanumeric field can be 
used as an internal reference. 

Estimated Start / Estimated End - The dates a work order is 
assigned to a technician and completion is expected.  

Status - An explanation of the work order progress. If the work 
order is to remain open, click the down arrow and select a 
status. 

Request – Additional information that is printed on the work order. 
The task code description appears by default, but you can type 
more details about the job. Information in this field is printed 
on the work order. 

The following options are available for WorkGroup and Enterprise users 
only: 

Contractor Subtab - The name of an independent contractor, if 
used. For additional information see Contract Management in 
the TMA User Guide. 

Project # – The number of the related project. Click the down 
arrow to select or create a project associated with the work 
order. This field is automatically populated if a project activity 
is converted to a work order from the Project window. 

Using the Item Selection Window 
After you click the down arrow in the Item # field: 

1. Click the appropriate radio button on the Item Selection 
Window to view a list of corresponding types.  
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2. Select either a specific type or All types to see related Item # 
and Description.  

3. Double-click the line item of your choice in the lower pane. (If 
the Work Order Building/Area fields are complete, the Item 
Selection Window list only includes items linked to the Area 
identified on the Work Order.) 
 

 
 

 Entities are not associated with a specific building or area. If the 
Entity radio button is selected for the search, the software displays all 
entity items connected to the same facility linked to the building and 
area on the work order. 

Report Options from the Report Manager 
Path: Reports > Report Manager 

This is not a complete list of work order reports available from the 
Report Manager window, but these are the more frequently used 
reports.  

Management Reports 
Path: Reports > Report Manager / Management 

Work Order Analysis by Type – A summary of all work orders by 
type, showing total quantity issued vs. total quantity and total hours 
completed. Information available: work order type, # issued, 
# completed, and total hours. Search based on request date.  

Work Order Completion Summary – A summary of all complete work 
orders. Information available: work order type, priority of work, # of 
Work Orders, labor cost, material cost, and total cost. Options: By 
selected repair center or all repair centers. Date range selection 
available based on the Complete Date field. 
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Work Order Received – A list of work orders received during a 
specified time frame. 

Work Order Statistics Detail – A detailed list of work orders sorted by 
building and subtotaled by facility and repair center. This report includes 
work type detail. 

Work Order Status by Facility – A summary list of all work orders, 
open and closed, subtotaled by repair center, including a breakdown by 
facility. Options: By selected repair center or all repair centers. Date 
range selection based on open and completion date. 

Work Order Status by Repair Center – A summary list of all work 
orders, open and complete, subtotaled by repair center. Work orders 
qualify if the Request Date or Complete Date falls within the date range 
specified. 

Status Reports 
Path: Reports > Report Manager / Status 

Work Order Aging List Sorted By Date – A list of all open work 
orders grouped by type and sorted by date.  

Work Order Aging List Sorted By Facility – A list of open work 
orders requested within a specified date range, sorted by facility. 
Information includes work order #, requested date, task code, task 
description, status, location id, building, estimated time, and estimated 
cost. Report options: By selected Repair center or all repair centers. For 
all locations in the selected facility or selected building. 

Work Order Aging List Sorted By Technician – A list of all open work 
orders for a specified date range, for one or all technicians. 

Work Order Aging List Sorted By Trade – A list of all open work 
orders sorted by date and grouped by trade. The report can be limited to 
one trade and repair center. 
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Chapter 4 
Scheduling and Assigning Work 
Orders 

Overview 
Assigning the open work order to a technician or group of technicians is 
the next step in creating a work order.  

One of the benefits of TMA software is the ability to review unassigned 
work orders either on a broad or a specific basis. You can request a list 
of all unassigned work orders or refine your search to specific criteria 
based on repair center, shop, trade, shift, and/or work order type.  

Scheduled Work Orders 
Work orders are identified for scheduling and reporting purposes as Not 
Scheduled or Scheduled. The assignment status is noted on each Tab of 
the Work Order window. 
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Whether you assign a technician from the Schedule Tab or from the TMA 
Scheduler window, the work order reflects the term Scheduled.  

 

Using TMA Scheduler  
Use the Scheduler window to assign multiple work orders and/or 
multiple technicians at one time. Two steps are involved in this process:  

1. Determine the criteria for the work orders you want to review 
for assignment. 

2. Assign technician(s) to the work order(s) for the date the work 
is to be done. 

Searching for Unassigned Work Orders 
Path: Transactions > Time Manager > Scheduler 

The following steps take you through the process of finding work orders 
that need to be assigned to a technician based on the selection criteria 
you determine.  
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1. Open the Scheduler window using the keyboard shortcut 
Ctrl+Shift+Q (Windows)—Command+Shift+Q (Macintosh)—or 
the menu path. 

 The Scheduling Criteria dialog box is active when you open the 
Scheduler window. The Scheduler window itself is inactive in 
the background. 

2. Make your criteria selections on the Scheduling Criteria dialog 
box (detailed in steps 3–7). 

 

3. Select a Zone if you want to search zones. The default is All 
Zones. The use of zones is optional in TMA software. 

4. Select a Shop. The default is All Shops. The use of shops is 
optional in TMA software. 

5. Select a Shift if you wish to search by shifts. 

6. Click the Trades you want to search or All Trades. 
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7. Click the Work Order Types or select All Types. 

8. Click OK on the TMA toolbar to close the Scheduling criteria 
window and start the search.  

Once the work order list is generated, you can assign technicians to 
perform the work.  

Assigning a Work Order from Scheduler 
Path: Transactions > Time Manager > Scheduler 

The Scheduler window is enabled after you: 

• Make selections in the Scheduling Criteria window  

• Click OK on the TMA toolbar 

To review a read-only copy of a specific work order, double-click the 
work order line in the Unscheduled Work section of the Scheduler 
window.  

 
 

One or more technicians or crews can be assigned to one or more work 
orders in a simple drag-and-drop action.  

1. Select a Technician or Crew line. 

2. Click-and-drag to the desired Work Order line. 

When you release the mouse button, the assigned technician(s), the 
work order number, and a colored bar display in the Gantt View. If a 
work order has been scheduled for the technician in advance, the work 
will also be displayed in the Gantt Chart pane. 

 

 Lunch Periods. The lunch period will display only when lunch is 
scheduled and occurs entirely within the shift. Therefore, the lunch 
period will not display if it:  
 • starts before the beginning of the shift 
 • ends after the shift is finished 
 • has the same start and end times (i.e., no lunch) 
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Estimated hours for a work order are pulled from an estimate if one was 
created for the work order. Hours can also derive from the PM Scheduler 
window if the Est. Time field is completed for the task.  

Click the Cancel button on the TMA toolbar to exit the Scheduler 
window.  

When you close the window, a message offers the option to batch print 
the scheduled work orders. Select Yes or No depending on your 
organization’s procedures.  

Viewing Workload from the Scheduler 
Path: Transactions > Time Manager > Scheduler 

To review a technician's work schedule on a daily, weekly, or monthly 
basis from the Scheduler window, follow these steps: 

1. Select the Technician whose workload you want to review.  

2. Click the Workload Subtab below the technician names. 

3. Click the Daily, Weekly, or Monthly Subtab under the right 
pane.  

4. On the Calendar, click the workload date you want to view to 
display color bars that represent assigned work orders and the 
start/end time. 

5. Double-click the bar to view details of the work order.  

Assigning a Work Order from the Work Order Window 
Technicians can also be assigned from the Schedule Tab of the Work 
Order window using the following instructions.  

Making Assignments from the Work Order Schedule 
Tab 
Path: Transactions > Work Order > Records / Schedule Tab 

1. Open the Work Order window.  

2. Locate the work order you wish to assign. 

3. Click Edit on the TMA Toolbar. 

4. Click the Schedule Tab.  

5. Type or select the ID Code / Name.  

 It is not a requirement that the selected technician belong to 
the trade assigned with the work order. 

6. Type the Start Date / Time. 

7. Click OK on the TMA Toolbar. 

Making Assignments Using a Keyboard Shortcut 
Path: Transactions > Work Order > Records / Identity tab 

1. Open the Work Order window.  

2. Locate the work order you wish to assign. 

3. Click Edit on the TMA Toolbar. 
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4. Use the keyboard shortcut, Ctrl+Shift+S (Windows) or 
Command+Shift+S (Macintosh), to open the Technician 
Selection window. 

5. Double-click to select the technician you want to assign. The 
selected technician is added to the ID Code/Name fields of the 
Schedule Tab with the current date in the Start Date/Time 
fields. 

6. Click OK on the TMA toolbar to save the record. 
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Chapter 5 
Printing Work Orders 

General Print Information 
Work orders can be printed using three different methods: 

• Individually (from Work Order or Work Order Browse windows) 
• Batch (from Work Order Browse or Batch Print windows) 
• Batch Print Override (from Batch Print window) 

Printing Individual Work Orders 
The individual print option allows you to find and print a single work 
order. 

Printing from the Work Order Window 
Path: Transactions > Work Order > Records 

Follow these step-by-step instructions to print one Work Order.  

1. Open the Work Order window. 

2. Locate the work order you wish to print. 

3. Click Print on the TMA toolbar. 

4. Click the destination icon of your choice on the Report 
Destination window. 

5. Click the OK button on the window. 
 

 Keyboard Shortcut: Ctrl+Shift+R (Windows) or 
Command+Shift+R (Macintosh) from the Work Order window opens the 
Print Setup window to allow you to select a specific printer or print 
source. 

Printing from Work Order Browse  
Path: Transactions > Work Order > Browse 

Single or multiple work orders may be printed from the Work Order 
Browse window.  

1. Highlight the Work Orders to be printed. 
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2. Click the Batch Print button at the lower right of the screen. 

To print selected lines in the list:  

1. Highlight the first line.  

2. Press and hold the Control key.  

3. Click each line item desired.  

4. Click the Batch Print button at the lower right of the screen. 

To print the entire list: 

1. Highlight the first line.  

2. Press and hold the Shift key. 

3. Click the last line in the list. This action highlights all lines 
between the first and last. 

4. Click the Batch Print button at the lower right of the screen. 

Batch Printing 
The default Batch Print option will print any open work orders that have 
not been printed in the past.  

Batch Printing Work Orders 

 
Path: Transactions > Work Order > Batch Print 

The batch print option will print any open work orders. If you select the 
Re-print work orders previously printed check box, work orders that 
have been printed in the past and meet the selection criteria can be 
reprinted.  

The selection choices are By request date or By schedule date for Trade, 
Work Order Type, and Repair Center.  
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 Schedule date is the date the work order was assigned.  
The Request Date field on the Work Order / Identity Tab reflects the 
date the request or work order was initiated. 

Step-by-Step Batch Printing 
Path: Transactions > Work Order > Batch Print 

1. Follow the menu path. 

2. Click the Individual Work Orders or Work Order Listing radio 
button on the Report options window. 

  

3. Click OK on the TMA toolbar. 

4. Select the desired output (Printer, Screen, etc.). 

5. Click OK on the TMA toolbar. 

6. Select the Starting Date and Ending Date of Work Orders to 
print.  

7. Click the radio button of your choice By request date or By 
schedule date. 

8. (Optional) Mark the Print all copies for multi-trade work order 
to print multiple copies for the work that qualifies. 

9. Select the Trade or All Trades.  

10. Select the WO Type or All Types. 

11. Select the Repair Center or All Repair Ctrs if available.  

12. Click OK on the TMA toolbar to open the Sort Options window. 

  
13 Choose the appropriate sort order.  



 

 
 

5-4 • Printing Work Orders TMA Basics Guide 

 

 

 

14. Click OK the TMA toolbar. 

To print previously printed work orders, see the next topic, Reprinting 
Work Orders. 

Reprinting Work Orders 
You can reprint work orders for different criteria. 

Reprinting Previously Printed Work Orders 
Path: Transactions > Work Order > Batch Print 

The Re-print items previously printed check box prints all open work 
orders that meet the criteria you specify including those printed in the 
past.  

This feature offers more selection criteria compared to the options on 
the Batch Print Override Subtab, which is limited to a range of work 
order numbers. 

1. Follow instructions in the Step-by-Step Batch Printing topic on 
the previous page.  

2. Click the Re-print items previously printed check box. 

3. Continue with the Step-by-Step Batch Printing process. 

Using Batch Print Override 
Path: Transactions > Work Order > Batch Print 

The Batch Print Override options print all work orders within a specified 
work order number range including those printed in the past. This option 
is less targeted than using the Re-print check box.  

 
1. Click the Batch Print Override Subtab. 

2. Select the Repair Center. This is required. TMA eXpress users 
are limited to a single repair center. Therefore, they have only 
one option.  

3. Type the Starting # and Ending # in a series. To print a single 
work order, use the same work order number in both fields. 
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4. (Optional) Click the Print all copies for multi-trade work check 
box. This option will print a copy of the work order for each 
trade scheduled on a multi-trade work order. 

5. (Optional) Click the Include Details check box. 

6. Click OK on the TMA toolbar. 

7. Select the sort order or accept the default. 

8. Click OK on the TMA toolbar to print the work orders. 
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Chapter 6 
Work Order Browse – Reviewing 
Work Orders 

Work Order Browse 
Sometimes you need to review both open and closed work orders 
created with TMA software. From the Work Order Browse window you 
can set the criteria you want to review and sort the work orders based 
on a number of available options.  

You can also:  
• View work order details  
• Zoom directly to the work order 
• Print the entire Browse list 
 

 

Using Work Order Browse 
Path: Transactions > Work Order > Browse 
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The Work Order Browse filters can yield very broad or very narrow 
results, depending on how many of the optional selections you choose. 
For example, you can browse for all work orders written for a facility 
during a long time period, or you can search for work orders scheduled 
for a particular technician of a specific type. The broader your search, 
the longer it can take to generate the browse list.  

1. Open the Browse Selection Criteria dialog box (Transactions > 
Work Order > Browse). 

2. Select the Beginning Date and Ending Date fields for the date 
range. You can also click the Today button, and select a range 
such as Today, Yesterday, This month, etc.  

3. Select a Work Order Type.  

4. Click the desired radio button to see Work Orders By Request 
Date, By Complete Date, or By Finish Date. 

5. Click the down arrow in the default Select Facility field to select 
from Building, Area, Zone, or item (equipment, tools, etc.) to 
narrow the search.  

 Depending on your selection, subsequent fields are available to 
further refine the search. 

 Example: If you seek work orders for a specific item number 
such as equipment, type the number in the next field or click 
the down arrow to make a selection. 

   

 The filtering feature of the selection window allows you to focus 
on the area or item of interest and reduce the time required to 
generate the list.  

6. Select your choice in the Open Only and Finished or Not 
Finished fields.  

7. (Optional) Type or select a Technician or Crew ID. The 
Schedules and Labor check boxes relate to the Technician. Hold 
the mouse pointer over the two check boxes for definitions.  

 The Retrieve shop and contractor info check box adds more 
detail to the Browse; however, it can slow the progress of 
generating the Browse list. 

8. (Optional) Select your choice of Task, Department, Shop, 
Trade, and Repair Center. 

 The default Repair Center is limited to the user who is logged 
in. If you have TMA Dispatcher access, click the down arrow to 
select your choice.  

9. Click OK on the TMA toolbar to start the search. 
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 A work order marked Finish indicates the work was done, but 
some requirements need attention before closing the request. A 
Complete work order is closed with no outstanding requirements. 

Sorting the Work Order Browse List 
Two buttons are located at the bottom of the window and are labeled 
Sort Fields… and User-Defined Sort.  

Click the Sort Fields… button to select one or more choices from the list 
of column headings. As soon as you make a selection from the list, the 
Browse window line items are sorted. 

Click the button to the right of the Sort Fields… button (the default name 
for the button is <<< User-Defined Sort) to sort by one of the following 
predefined groupings: 

• Repair Center, Facility, Department, Building 

• Department, Work Order # 

• Supervisor, Trade, Priority, Date 

• Trade, Priority, Date 

To enable to the Sort Fields… button once more, click the User-Defined 
Sort button (the name of a predefined group may be displayed but it's 
also the User-Defined Sort button), and select the first option <<< User-
Defined Sort on the list. 

Removing Entries from the Browse List 
To remove selected work orders from the browse list, highlight the work 
order line item on the list, and click the Remove button. 

 Using the Remove button does not delete the work order record 
from the database; it merely eliminates it from the browse list. 

Work Order Browse Context Menu Options 
When you select a line or multiple line items in the Work Order Browse 
window, you have the following options on a right-click context menu:  

• E-mail Work Order to Technician 

• Schedule Selected Work Order 

• Update Selected Work Order as Completed (closed) 

• Change Status On Selected Work Order 

E-mail to the Technician 
If e-mail settings have been established for your repair center, you can 
e-mail the assignment to technicians from the Work Order Browse list.  
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 The e-mail function must be part of the setup for the repair 
center. Also, e-mail addresses for technicians must be included in the 
Technicians window (Organization > Repair Center > Technicians). 

To use e-mail:  

1. Highlight a line in the list. 

2. Right-click the selected line for a context menu.  

 Note: If the work order has not been assigned, the system 
includes the line No Technician Scheduled. 

3. Select E-mail Work Order To:[technician name]. 

 If the work order is assigned to more than one technician, you 
can also select E-mail Work Order To:All technicians. 

4.  Click your selection to send the message. 

When you click your selection, an e-mail window opens with the address 
of the technicians.  

 

The work order number is shown in the Subject field, and work order 
information is in the message body field. The From address is 
established in Organization >  Repair Center / E-mail Configuration Tab.  

Schedule Selected Work Order 
1. Highlight a line item in the list. 

2. Right-click the selected line.  

3. Select Schedule Selected Work Order. 

4. Select a Technician or Crew from the Select Technician window. 

5. Double-click to schedule the selected Technician or Crew. 

When the Select Technician window closes, the assignment is made. 

Complete Selected Work Order 
1. Highlight a line item in the list. 
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2. Right-click the selected line.  

3. Select Update Selected Work Order As Complete. 

4. Click Yes on the message box if you want to close the work 
order. 

The work order is closed and the Work Order Browse window reflects the 
current date as the Complete Date. 

Change Status on Selected Work Order 
1. Highlight a line item in the list. 

2. Right-click the selected line.  

3. Select Change Status On Selected Work Order. 

 
4. Select the status on the Work Order Status… window. 

5. Click OK on the TMA toolbar.  

6. Scroll to the right. The status is displayed in the column labeled 
Hours / Status. 

When you change the status from work order browse, the work order 
record is also updated. If you zoom to the Work Order window from the 
Browse window, you will see the new status displayed in the Status field. 
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Viewing Details of the Work Order 

 
To see the details of a particular work order without exiting the Browse 
window, click the Show Detail button. Items such as Action Requested, 
Task Code, and Location are available on the Work Order Detail window. 

The Zoom button is available on both the browse list and the Work 
Order Detail window. Zooming to the work order closes the Browse list 
window and opens the Work Order window. 

On the browse list, select a line item and click the WO Zoom button or 
double-click a line item in the list to open the Work Order window. 

 Click the Zoom button on the Work Order Detail window to view 
the actual record. 

Making a New Browse Selection 
The software retains the last browse selection until you log off from TMA 
or generate a new list. For example, if you make a browse selection and 
close the Browse window to work on a different module or if you choose 
Zoom to view a work order, the same browse selection opens when you 
return to the Work Order Browse window.  

To make a new browse selection: 

1. Click the New Browse Selection button.  

2. Change the desired fields on the Browse Selection Criteria 
window.  

3. Click OK on the TMA toolbar to start the new search. 
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Printing Work Orders from Work Order Browse 
You can print specific lines or all lines from the browse list.  

Selected lines in the list. Highlight the first line, press and hold the 
Control key, and click each line item desired. Click the Batch Print 
button. 

Entire list. Highlight the first line, press and hold the Shift key, and 
click the last line in the list. This action highlights all lines between the 
first and last line selected. Click the Batch Print button. 

Printing a Work Order Browse Report 
Two reports on the items displayed in the Work Order Browse window 
can be printed directly from the window. Check boxes located below the 
list provide the choices. The buttons are:  

• Include Additional Info 

• Include Action Requested on Report 

Generate the browse list and check one or both of the report choices. 

To print the report: 

1. Click Print on the TMA toolbar.  

2. Choose the desired print option (screen, printer, etc.). 

3. Click OK on the TMA toolbar. 

 
 Example of Include Action Requested Report 
 

The Show Action Requested option includes the instructions typed in the 
Action Requested field on the Work Order > Identity Tab but does not 
show the Job Code/Description. 

 
 Example of Include Additional Info 

Include Additional Info prints the task code and corresponding 
description, but does not include the action requested. 

If you select both check boxes, you can see both the request and the 
task code. 
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Chapter 7 
Recording Work Order Time 

Overview 
There are several ways to record the amount of time worked in 
connection with a work order. This Basics Guide covers the use of two:  

• Quick-Post Time & Labor  

• Work Order / Charges Tab  

Recording Work Order Time – Quick-Post Time & Labor 
Path: Transactions > Quick-Post > Time and Labor 

Use the Quick-Post modules to record work order time in a batch format. 
This saves data entry time because data is entered without opening and 
closing individual work orders.  
 

 

Use the Quick Post Time & Labor module to enter work order information 
such as: 

• Who performed the task  
• When the work was done 
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• Amount of time required  
• Labor account number  
• Complete date 
• Corrective action  

The fields that must be completed depend on the type of work order, but 
a minimum number are always required. These are listed in the 
following topic, Using Quick-Post Time & Labor.  

Technicians’ indirect time such as meetings, sick time, etc. can also be 
entered from this window.  

 The posting list generated on these windows is not saved until 
you click OK on the TMA toolbar. Be certain to save your work every 8-
10 lines. 

Using Quick-Post Time & Labor 
Path: Transactions > Quick-Post > Time & Labor 

1. Follow the menu path to open the window. 

2. Type the Work Order #. If no work order number is entered in 
this field, only indirect time can be posted.  

 To view and select from a list of open work orders, type /R and 
tab out of the field. (Other shortcut keys include: /E for a list of 
equipment work orders, /A for assets, /V for vehicles, /G for 
groups, and /T for tools.) 

3. Type or select the Technician #. This is the ID of the technician 
who performed the work. 

4. Tab out of the Technician # field. The Date of Work field 
defaults to one day prior to the current date. Select a different 
date if needed. 

5. Type the number of Hours and Start Time. The default format 
for the Start Time field is military (24 hour) time. 

 The Start time check box next to the Comment button indicates 
whether the Start Time field is available. To enable the option, 
click the check box. If the Start Time check box is blank, the 
cursor skips the Start Time field. The Approved check box is 
used by those who have rights to approve time cards. 

6. Type or select the Type Hrs (Regular Time, Overtime, Travel). 
The default for this field is the time type of the selected work 
order. 

7. Accept the default Shift (defaults from the technician's 
personnel record), or type a different Shift code.  

8. Type the desired Complete? field option to close the work 
order. Options are: 
 N - do not close the work order (the default)  
 Y - close the work order  
 C - close only the current trade (for multi-trade WO) 

 The software displays the current work order trade in the 
Quick-Post window. When C is selected, only the specific trade 
is closed. When a work order number is typed in the field later, 
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the next trade (that follows the closed trade) is displayed on 
the Quick-Post window. 

9. Tab through the Date / Time Closed fields to show the current 
date and time if Y or C is typed in step 8, or type the desired 
close date and time. 

10. Tab out of the Time Closed field to clear the screen and create 
another active data line, unless the work order is chargeable. 
 
If chargeable, press the Tab Key to move the cursor into the 
Account field (See QP Time & Labor - Optional Fields). An 
account number must be entered before the transaction can be 
saved. 

11. Click OK on the TMA toolbar to save your work. Until you 
actively save the input, it is not recorded. This should be 
done every 8-10 lines. 

12. Click Cancel on the TMA toolbar when all entries are saved. 

Quick-Post Time & Labor – Optional Fields 
Path: Transactions > Quick-Post > Time & Labor 

Account # - If the work order is chargeable, type or select the TMA 
account # responsible for providing the work. This is not the  
number from the Work Order / Identity Acct # field. 

Failure Code - is used for failure analysis reports. Click the down 
arrow to select a code from the selection list. 

Quick-Post Time & Labor - Technician Report 

 
 

If you want to add the technician’s report to the work order, press Alt+C 
or click the Comments button to open the free-form text window.  
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 To save data, you must click OK on the TMA toolbar from the 
Quick-Post Time & Labor window. 

Recording Time – Work Order / Charges Tab 

 
Path: Transactions > Work Order > Records / Charges Tab 

The Quick Post function is the most efficient method to record hours for 
multiple work orders, but you may find it easier to record hours for a 
single work order from the Work Order / Charges–Labor Subtab.  

Recording Time from Work Order 
Path: Transactions > Work Order > Records / Charges–Labor Subtab 

1. Locate the Work Order record. 

2. Click Edit on the TMA toolbar.  

3. Click the Charges Tab. The default view is the Labor Subtab. 

4. Place the cursor in the Technician ID field. You can also use the 
right-click context menu to Copy all scheduled technicians to 
labor list from the Schedule Tab. 

5. Type or select the Technician or Crew ID. 

 To view a list of technicians associated with a specific trade, 
select a Trade or All Trades (Dispatcher access only) on the 
Select Technician window. 

 From the lower portion of the Technician Selection window, 
select the name of the technician who performed the work. 
Double-click to populate the Technician ID field. When a 
technician is selected, the fields for Time Type, Trans Date, 
Shift, and Account will populate if the default information has 
been set up in TMA. 



 

 
 

TMA Basics Guide Work Order Time  • 7-5 

 

 

 

   

6. Accept or select the default Time Type. The default is 
determined by your repair center affiliation.  

7. Accept or select the default Trans Date. This is the date that 
work was actually performed.  

8. Accept or select the default Shift. The default is the first shift 
unless the selected technician has an assigned shift set up in 
the technician record.  

9. Type the number of Hours worked by the technician.  

 TMA software calculates the total cost of labor by multiplying 
the hours worked by the charge rate for the selected technician 
(established on the Technician window). Other costs such as 
rate multiplier and shift differentials are also considered in the 
calculation if these are used. 

10. (Optional) Type or select the Account #. This refers to the 
credit account of the department responsible for providing the 
work; typically this is the maintenance department or the labor 
account number for the technician. This is a required field only 
if the work order is specified as chargeable on the Work Order / 
Identity Tab.  

A work order is made chargeable (or not) by designating YES or 
NO in the Charge? field of the Work Order / Identity Tab screen. 
If YES is in the field, the work order is chargeable. 

When you tab through the Account # field, a new active data line 
appears, and you can add hours for additional technicians. 

Results Tab – Technician’s Report 
Path: Transactions > Work Order > Records / Results Tab 

The Technician’s Comments Subtab on this window includes a large text 
Technician’s report of corrective action taken field that provides space to 
type actions made by the technician. In addition, other notations 
regarding the work order are added here.  
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Results Tab – Check List 
Path: Transactions > Work Order > Records / Results–Check List Subtab 

 

The Check List Subtab on the window displays any required actions 
where the technician can check off the items and mark as Pass/Fail or 
other results.  

Checks can be added to the window. In most cases, they are associated 
with a specific task, and the technician clicks the Edit button on the 
window to add his or her findings. 
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Chapter 8 
Closing Work Orders 

Overview 
Path: Transactions > Work Order > Records / Results Tab 

A date entered in the Finish Date field on the Work Order / Results Tab 
indicates that the work itself is done but some requirements are 
outstanding. A date in the Complete Date field on this window indicates 
that the work order is closed; however, labor hours and other costs can 
be added to a closed work order.  

A closed work order can also be reopened to add information if the user 
has appropriate privileges. Work orders are reopened by clearing the 
Complete Date field. 

How to Close Work Orders 

 
Path: Transactions > Work Order > Records / Results Tab 

Work Orders can be closed in the Work Order window or from the TMA 
Quick Post function. See the previous chapter for details on closing work 
orders using Quick Post.  

Follow these steps to close a work order from the Work Order window: 

1. Open the Work Order window. 

2. Locate the completed work order. 

3. Click Edit on the TMA toolbar. 

4. Click the Results Tab. 

5. Type the date that the work was finished in the Finish Date 
field. The time of day defaults to the current hour and minute 
but can be modified.  
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 When the Complete Date field is populated a work order is seen 
as closed by TMA. 

 The read-only fields display the length of time the work order 
has been open, not the number of hours worked.  

 The software calculates the time elapsed from the request 
Date/Time to the Finish Date or Complete Date and Time fields 
on the Work Order / Results Tab. 

 The time elapsed is not a record of the labor hours for the work 
order. The Finish Date does not impact TMA reports, but the Complete 
Date is used in reports. 

Failure Codes 
Path: Transactions > Work Order > Records / Results Tab 

Failure codes are used in conjunction with the planned maintenance and 
work order modules. The failure code is an optional field used to track 
failures related to equipment, vehicles, areas, and assets.  

A Failure Analysis report is available in Report Manager / Status that 
allows you to review the PM or work order that failed, why it failed, and 
how frequently failure occurred.  

The Failure Code field includes a down arrow so you can select the 
reason for failure. 

You can track failures with the Failure Analysis Report for all types of 
work orders. They do not have to be related to PM work orders. 

Failed PM 
If the item or area identified failed on the PM work order, click the Failed 
PM check box on the Work Order / Results Tab to indicate the failure.  

Work Not Done 
If no action is taken on a work order, click the Work Not Done check box 
to indicate the fact that the PM or task was not completed because of 
the failure.  

 You may check both the Failed PM and Work Not Done boxes. 

Report Options 

Management Reports 
Path: Reports > Report Manager / Management tab 

The following identifies some of the more frequently used reports related 
to work orders. It is not an all-inclusive list.  



 

 
 

TMA Basics Guide Closing Work Orders • 8-3 

 

 

 

Work Order Status by Facility – A summary list of all work orders, 
both open and complete, subtotaled by repair center including a 
breakdown by facility. Work orders qualify if the request or completion 
date falls within the date range specified.  

Work Order Status by Repair Center – A summary list of all work 
orders, both open and closed, subtotaled by repair center. Work orders 
qualify if the request or completion date falls within the date range 
specified. 

Work Order Completion Summary – A summary of all completed 
work orders. Information available: work order type, number of work 
orders, labor cost, part cost, and total cost. Options: By selected repair 
center or all repair centers.  

Trade Work Order Report – A list of all work orders requested within a 
specified date range, sorted by trade. This report shows all trades for 
multi-trade work orders. For this reason, work orders are repeated for 
each trade. Cost and hours for the total work order are reflected on each 
trade. For purposes of this report, the terms ‘open’ or ‘complete’ refers 
to the specified trade only. 

Status Reports 
Path: Reports > Report Manager / Status  

Complete Work Orders – Work orders completed for a selected date 
range.  

Failure Analysis – A detailed list of failures reported on work orders for 
equipment, vehicles, assets, and areas. Information available: work 
order # dates, requested action, and corrective action taken. 
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Chapter 9 
PM Generation 

Introduction 
Planned Maintenance (PM) is a function that allows you to schedule PM 
procedures for areas, equipment, assets, vehicles, tools, entities, or 
groups.  

PMs are scheduled for fixed or floating dates and for frequency intervals 
such as daily, weekly, monthly, yearly, or unit. 

Once items have been scheduled, work orders can be generated from 
the Transactions > Generate PMs menu. 

This TMA Basics Guide assumes the PM schedules have been established 
and are available for generation.  

Generating PM Work Orders 
After the schedules for planned maintenance items are established using 
the PM Scheduler window, generating the work orders requires human 
interaction to start the process. Someone in your organization must be 
assigned the responsibility for generating PM work orders on a regular 
basis. 

At some work sites, this task may occur on a weekly basis; at others it 
may be monthly. The time frame used to search ahead for PMs that 
need to be generated is defined by each repair center. If that number is 
defined as 7, the system looks for PMs due in the next 7 days from the 
day PMs are generated.  
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PM Generation Window 

 
Path: Transactions > Generate PMs / Basic Filters 

The Generate PMs window is designed to give you numerous filters so 
you can have PM work orders only for the items you want. 

Basic Filters 
The Basic Filters Tab has a number of default settings identified below. 
When generating PMs, you can select your desired settings.  

PM Types – All item types are selected by default. Click to 
clear a check box. Only items with a mark in the check box 
will be available for PM generation. 

Departments - All departments are selected by default. Click 
to clear a check box. Only departments with a mark in the 
check box will be available for PM generation. 

Manual Selection – A preview list of scheduled PMs that are 
due. This option is preferred until you are familiar with the 
results from your selections. From the preview list, you can 
elect to generate some or all PMs.  

PM Generation Days - The number of calendar days you want 
to include in this generated list of PMs. The default number 
displayed is set by your TMA System Administrator in 
Organization > Repair Center > Records / Preferences.  

Repair Center – The user’s assigned repair center. (Users with 
Dispatcher access have other options.) 

Zone - All Zones is selected by default. Click the down arrow to 
choose a specific zone. If one zone is selected, only that 
zone will be used for PM generation. 

Building – All Buildings is selected by default. Click the down 
arrow to choose a specific building. If one building is 
selected, only that building will be used for PM generation. 
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Shop – All Shops is selected by default. Click the down arrow 
to choose a specific shop. If one shop is selected, only that 
shop will be used for PM generation. 

Trade – All Trades is selected by default. Click the down arrow 
to choose a specific trade. If one trade is selected, only 
that trade will be used for PM generation. 

Account, Technician, Contract # – These fields are blank by 
default. You can type or select the account and technician. 

 When a specific technician is selected on the Generate PMs 
window, only PMs assigned to the technician you select will be 
generated. When a technician is selected, all other criteria (risk level, 
buildings, and types of schedules) are disregarded in the search. 

Advanced Filters 
The Advanced Filters Tab is enabled when only one PM Type is selected. 

 

Click the Advanced Filters Tab to select the types.  

If Equipment PM is selected, additional Equipment Priority fields are also 
available on the Advanced Filters Tab.  
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Equipment Priority – The All risk levels radio button is selected by 
default. Click a radio button to select a specific level. As with all 
radio button choices, only one button can be selected. This 
information relates to the Risk Level field on the Organization > 
Equipment / Identity Tab. 

How to Generate PM Work Orders 
Path: Transactions > Generate PMs / Basic Filters 

1. Open the PM Generation window. You can also use the 
keyboard shortcut Ctrl+Shift+G (Command+Shift+G for 
Macintosh). 

2. Determine the selection criteria the system will use to generate 
PM work orders.  

3. Click OK on the TMA toolbar.  

 If you are using manual selection, the PM Due for Assignment 
window opens for you to view a list of PM schedules that meet 
your selection criteria. 

 
 NOTE: If you click the Automatic Selection button to 

automatically generate all PM schedules, this option does not 
allow a preview of the list or an opportunity to make selections 
before creating PM work orders. 

4. Highlight the desired lines. 
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 For multiple selections, use the Microsoft multiple selection 
convention Shift+Click for adjacent lines in the list or Ctrl+Click 
for non-adjacent lines. 

5. Click OK on the TMA toolbar to generate a PM work order from 
the PM Due for Assignment window. 

 A message box prompts you with a query to print all PM items 
just generated.  

6. (Optional) Click No to exit the message window and return to 
the home screen. You can always print them individually from 
the work order window if needed. 

7. Click Yes for available print options.  

All items generated are printed as a work order. 

 The PM Due for Assignment list may include some past due 
schedules. If a PM schedule is due but is never generated into a work 
order, it remains available for the PM generation list until generated. 
 
A blue icon next to a task code in the list indicates the line item is a 
consolidated PM – that is, it includes more than one PM. In consolidated 
PMs, all PM tasks are included on a single work order.  

Sample PM Work Order 
A partial view of a PM work order generated by the PM Scheduler is 
shown below. If a PM task sheet has been completed for the PM task, 
the procedure is printed on the work order.  

 

PM Generation – Options for Refining the Search 
To narrow the search when generating PM work orders: 

• Clear a check box next to one or more PM item types in the 
Select PM Schedules section. This narrows the search to include 
only PM item types that are marked.  

• Click a radio button in the Equipment Priority section of the 
Advanced Filters tab to generate a PM for specific Equipment 
Priority/Risk Level. If you do not have sufficient time or 
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resources available to complete all of the equipment PM 
schedules, the Equipment Priority options allow you to generate 
those with the highest risk factors first. 

• Generate PM schedules for a particular building by choosing the 
building from the selection list in the Select Building field. 

• Generate PM schedules assigned to a particular technician by 
selecting the name from the Select Technician window opened 
from the Technician field. When a technician is selected, all 
other criteria (such as priority, buildings, and types of 
schedules) are disregarded in the search. 

 Selection of Asset PM and Tool PM are available in WorkGroup 
and Enterprise only. 

Report Options 
Following are some of the many reports related to generating planned 
maintenance work orders that are available in the TMA Report Manager.  

PM Reports 
Path: Reports > Report Manager / PMs 

PM-Complete – All complete PM work orders with a completion date 
within the specified date range. Selection criteria include date range and 
repair center. Information available: work order, location information, 
task code, and description, tag #, and request date. Totals include: 
Total number of PMs, materials cost, and labor cost. 

PM-Open – All open PM work orders with request date within the 
specified date range. Selection criteria include date range and repair 
center. Information available: work order, location information, task 
code, and description, tag #, and request date. Sorted by request date. 
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Appendix A 

TMA Menus 

File 

Open Library Used for accessing the TMA software files. 

Preferences 
Page setup 

Set print destination 
User Preferences 

These options include change printer settings, 
toggle text on the toolbar menu, and background 
display. 

Bookmarks 

Add Bookmarks 
Edit Bookmarks 

This selection allows users to flag records for quick 
retrieval. 

Statistics A tabbed window display of the current number of 
records and table schema within TMA software. 

TotalView Cascading list of all records set up in the data file. 

My Tasks A reminder list that is created from the Attachment 
tab window in a number of TMA functions. 

GIF Viewer A window to view .gif graphics files 

Page Technician A window used to send paging messages. 

Message History A searchable message log used to locate previous 
messages. 

Log off Allows user to log out of TMA software and log back 
in without re-launching the application. 

Quit Closes the TMA software program. 

Edit 

Standard edit menu options for editing (cut, paste, select all) fields and records in TMA 
software. 

 

Depending on the Purchase Options and TMA version you use, menu commands will 
vary. Not all menu commands are available with all versions of TMA. 
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Transactions 

Request 
 Log 

 Batch Validation 
 Browse 

Allows users to store all work requests in one place, 
giving the option to reject or accept the requests. 
Accepted requests can be changed into a work order from 
these windows. 

Work Order 
 Records 
 Browse 

 Batch Print 
 Confirmation 

 Individual Billing 
 Quick Work Order  

 Authorization 

Access to the Work Order records as well as features 
related to browsing, confirming, authorizing, and printing 
existing work orders. 

Quick-Post 
 Time & Labor 

 Material 
 Rental/Other Charges 

 Labor by Technician 
 PM Meters 
 Fuel & Oil 

 Training 
 CM Readings 

 Down Time  
 Refrigerant Service 

Used to batch post data for faster processing. 

Time Manager 
 Time & Attendance 

Staff Schedules 
 Scheduler 
 Calendar 

 Review Assignments 
 Batch Attendance 

 Gantt Review 

Menus used to view technician’s schedules, assign open 
work orders, plan schedules, and review assignments on 
a daily and weekly basis.  

Gantt review of all work orders for a given day or by 
individual trade or technician. 

Refrigerant Service Document use of refrigerant from a cylinder (or piece 
equipment).  

Fuel & Oil Document individual fuel and oil ticket items along with 
payment and billing information. 

Returns & Repairs Track defective items that are returned to the 
manufacturer or vendor for refund or repair. 

Project 
 Records 

Browse 
 Requisitions 
 Gantt Chart 

TMA software defines a Project as a work request that 
requires multiple work orders. All expenses, including 
labor, material and other charges are linked automatically 
to the project. Gantt charting is available for tracking 
progress of the project. 

Estimate 

Records 
 Change Orders 

Estimates linked to any Request, Work Order, Project, or 
Project Task. When any estimated items are converted to 
a Work Order, the TMA software automatically links the 
original Estimate information to the Work Order. 

Depending on the Purchase Options and TMA version you use, menu commands will 
vary. Not all menu commands are available with all versions of TMA. 
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TRANSACTIONS 
Pending Authorization Used with TMA Authorization Routing. 

Generate PMs Used to generate work orders from scheduled planned 
maintenance tasks that are currently due. Users can 
select all or specific categories (i.e., equipment, areas, 
vehicles, etc.) and have the option to generate all or 
manually pick from the list. 

Facility Scheduler 

Reservation Request Wizard 
Reservation Request 

Reservation 
Expense Ticket 

Reservation Request 
Planboard 

Reservation Planboard 

Used with the optional Facility Scheduler module to 
request and reserve Facility areas and items such as 
equipment and tools.  

Vehicles are requested and reserved using the Fleet 
Management option module. 

Materials 

Vendors Contains detailed contact information related to Vendors 
and outside Contractors who provide Materials or labor.  

Manufacturers Details contact information regarding manufacturers of 
equipment and linked to item records. 

Warehouse Records related to warehouses and linked to part records 
with additional feature to select a repair center to filter 
access for facilities using multi-repair centers. 

Parts 
 Records 

 Kits 
 Transfers 
Cross Reference 

Detailed information about a stocked item. Items can be 
cross-referenced to equipment, vendor, or vehicle 
records.  

On-hand Adjustments Tracks adjustments, both positive and negative; worker 
return; order arrival; part issuance; and defective parts. 
Automatically logs parts entered on the Work Order to 
track stock movement in and out of the Warehouse.  

P-Card 

Transactions 
Reconcile 

Used to record and track purchases made with Purchase 
Cards. 

Purchases 

Requests for Quote 
 Purchase Reqs 

Purchase Orders 
Change Order 

Stock Replenishment Wizard  
Receivings 

Used to request a pricing Quotation, to request 
authorization from a manager to place an order for parts 
or materials, or to issue an order from Vendors. Quotes 
and Requests can be converted into a Purchase Order 
within TMA software. Receipt of purchased items is 
tracked through Receivings. 

Sales 

Material Request 
Sales Order 

Used to request and sell material from the Warehouse to 
other departments within the organization. Includes 
accounting functions. 

Depending on the Purchase Options and TMA version you use, menu commands will 
vary. Not all menu commands are available with all versions of TMA. 
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MATERIALS

Material Browse Used to review lists of items that have been requested or 
purchased from Vendors or the Warehouse. 

Tools 

Records 
Transfers 

Reservation Request Wizard 
Reservation Requests 

Reservations 
Expense Tickets 

Used for recording information on tools and tool usage, 
including PM. Transfer the "home base" for tools to a new 
location. 

If you purchase the Facility Scheduler module, the Tools 
reservation-related menu commands are also available. 

Hazardous Materials Used for tracking specific details on hazardous material, 
including MSDS files, and user precautions. 

Refrigerants A record of Refrigerant types, volume, location, condition, 
and other pertinent information. 

 

Accounting 

Accounts Table for defining account numbers and account 
descriptions from which expenses may be charged or 
credited. When work orders are written and charges are 
posted to an account, TMA software rolls up the labor 
cost, hours, and material costs to the account record.  

Contracts A record of Contracts held with outside service providers. 

Rate Schedules Markups applied to line items. 

Depreciation TMA software allows the user to track depreciation on 
equipment, assets and vehicles.  

ACI Asset Condition Index used to compare the condition of 
assets on a yearly basis. 

Post Charges Used to roll up costs to the respective accounts. 

Project Rollups A process used to roll up the totals for work orders and 
project requisitions into the Project record account fields.  

Cost Rollups Used to posts costs to the appropriate accounts. 

Accounts Receivable 
Invoices 

Payments 

Records to batch pay, view, add and delete account 
receivables. User access must be available. 

Accounts Payable 
Invoices 

Payments 

Records to batch pay, view, add and delete account 
payables. User access must be available. 

Purge Accumulatives Shifts accumulative display of year-to-date or month-to-
date to the next level in record windows. TMA software 
holds four years of previous data plus the current year.  

 
 

Depending on the Purchase Options and TMA version you use, menu commands will 
vary. Not all menu commands are available with all versions of TMA. 
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Organization 

Lookups Used for entering pick list data and defining categories of 
items displayed in selection windows and for 
distinguishing data for report options. 

Repair Center 
Records 

Shops 
Technicians 

Crews 

Used to establish criteria to access, display and report 
information within TMA software related to areas of 
responsibility. Technician records are linked to trades, 
shops, and repair centers from this menu. 

TMA eXpress is limited to one Repair Center. 

Departments Records of individuals or organizations that occupy or 
have financial responsibility for maintenance costs 
incurred for certain spaces within the facility (can be 
linked to other records in the TMA system). 

Customers Information about the people in your organization who 
use the items and services provided by your facility 
maintenance department.  

Facility Records for the highest level of the 3-tier location 
hierarchy in TMA software and for non-structural 
components of a Facility that require maintenance 
(entities). Ultimately all costs (both Building and Area 
costs) roll up to the Facility level.  

Building 
Records 

Sites 
Leases 

Trip Standards 

The second level of the three-tier location hierarchy 
contains all the building records within a facility and 
associated site and lease information. Labor, materials, 
and other costs roll up from associated work orders.  

Area 
Records 

Reservation Request Wizard 
Reservation Requests 

Reservations 
Expense Tickets 

Inspection Forms 
Inspections 

Inspection Browse 
Load Inspections 

Inspection HotSync Setup 
HotSync Messages 

The third and lowest level identifier in TMA software’s 
three-tier-location hierarchy. Most items in TMA software 
are linked to area records. All associated costs roll up to 
the Building where the Area is linked. The Area level is 
usually synonymous with the rooms within a Building.  

Reservation commands are available if you have 
purchased the Facility Scheduler optional module. 

Inspections commands including HotSync Messages are 
part of the the Room Inspection optional purchase 
module. 

Entity 
Records 

Reservation Request Wizard 
Reservation Requests 

Reservations 
Expense Tickets 

 

Standalone items such as benches, lamp posts, and 
portable signs can be classed as entities. 

Reservation commands are available if you have 
purchased the Facility Scheduler optional module. 

 

Zones An optional method to associate items in a geographic 
area. 

 

Depending on the Purchase Options and TMA version you use, menu commands will 
vary. Not all menu commands are available with all versions of TMA. 
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ORGANIZATION

Equipment 
Records 

Transfers 
Reservation Request Wizard 

Reservation Requests 
Reservations 

Expense Tickets 

Mechanical or electronic items that may require a planned 
maintenance schedule.  

Reservation commands are available if you have 
purchased the Facility Scheduler optional module. 

 

Biomed Equipment 
Records 

Transfers 
Reservation Request Wizard 

Reservation Requests 
Reservations 

Expense Tickets 

Clinical Engineering mechanical or electronic items used 
by Healthcare licensees. 

Reservation commands are available if you have 
purchased the Facility Scheduler optional module. 

 

Asset 
Records 

Transfers 
Reservation Request Wizard 

Reservation Requests 
Reservations 

Expense Tickets 

Non-mechanical items that require maintenance. 

Reservation commands are available if you have 
purchased the Facility Scheduler optional module. 

 

Vehicle 
Records 

Transfers 
Reservation Request Wizard 

Reservation Requests 
Reservations 

Expense Tickets 
Reservation Request 

Planboard 
Reservation Planboard 

Detailed records of Vehicles within a facility.  

Reservation commands are available if you have 
purchased the Fleet Management optional module. 

 

Group 
Records 
Checks 

Records of multiple items collected to save time when 
scheduling and applying the same job/task, including 
preventive maintenance and condition checks.  

Cable Tracking 
 Cables 

 Cable Pairs 
 Jacks 

 Panels 

(WorkGroup & Enterprise only) Allows the user to track 
Cables, the Pairs that comprise the Cables, Panels, Jacks, 
and connected equipment to produce a complete signal 
trace from the Panel of origin to the Jack or connected 
device. 

Task 
 Library 

 PM Scheduler 
PM Load Balancing 

Master Check Items 

A Library and Scheduler that contains Task codes and 
Task descriptions defining Tasks that can be assigned to a 
Work Order and/or to create a calendar or meter 
schedule to generate PM Work Orders. 

 

 

 

Depending on the Purchase Options and TMA version you use, menu commands will 
vary. Not all menu commands are available with all versions of TMA. 
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Reports 

Report Manager  More than 350 report options and graphs with optional 
criteria 

Active Reports An advanced report writer designed to help the user 
create custom reports that are not included with the 
Report Manager. 

Ad hoc Reports 
 New 

 Open 

A flexible report generator designed to help the user 
create custom reports that are not included with the 
Report Manager. 

Crystal Reports 

New 
 Open 

You can use this interface connection to include reports in 
TMA that you created outside of TMA using Crystal 
Reports. 

Data Dictionary Utility to store the current design library file formats to 
the data file. 

Data Collections Form Forms used to assist in collecting initial data on items to 
be entered in the TMA system. 

Executive Dashboard Used to view the Dashboard monitors created using the 
options Executive Dashboard module. 

SQL Query Window Used by Advanced TMA administrators. 

Admin 

Preferences Fields to set date format; to set counters for Purchase 
Orders/Requisitions and Projects, and to establish some 
global changes to nomenclature within TMA software. 
Also allows user to choose inventory valuation method 
and default cash account. 

LDAP Setup Used to configure LDAP Settings from TMA. 

iServiceDesk 

Server Manager 
Secured Pages 
RetrieveHTML 

Used by clients who purchase the optional iServiceDesk 
module to set up and administer users and HTML pages. 

Security 

Groups 
Users 

Records to determine a user’s level of access to windows 
and records in TMA software. 

Approval Routing Used to set up the routes for clients who use the Routing 
Authorization System. 

Executive Dashboard 

Dashboards 
User Assignment 

Used by clients who have purchased the optional 
Executive Dashboard module to create, edit, and assign 
the Dashboard displays. 

Field Attributes Editor Option to designate properties of fields within a record. 

 

Depending on the Purchase Options and TMA version you use, menu commands will 
vary. Not all menu commands are available with all versions of TMA. 
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ADMIN
Single User Functions Used to view and release users logged using Post Project, 

Post Charges and PM Generation functions. 

View Logins  Used by the TMA System Administrator to review the 
users who are logged in to TMA. 

Purge Records Utility to purge records from the TMA Data File. Use with 
caution. 

Activate All Used to activate all records previously tagged Inactive. 

SQL Error Log Used by Advanced TMA administrators to view SQL 
Errors. 

Options 

Retrieve E-mail Requests 

CAFM 

Event Scheduler 

Key Management 

Utility Management 

mobileTMA 

The selections on this menu provide access to purchased 
options available with the TMA Studio products, with the 
exception of Barcode Manager. TMA supplies bar code 
fonts to WorkGroup and Enterprise clients so Work Order 
numbers and other items can be printed as bar codes.  

Commands 

Menu selection of commands used to perform basic records handling functions. 

Help 

Access to Help files associated with the TMA software. Also includes the About TMA menu that 
provides specific information used by TMA Technical Support. 

Spell 

Spell checking by field or by window. 

Window 

Displays information about open windows and allows user to close or print a window. 

 

 

 
 

Depending on the Purchase Options and TMA version you use, menu commands will 
vary. Not all menu commands are available with all versions of TMA. 
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Appendix B 

Shortcut Overview 
TMA includes numerous keyboard shortcuts to enhance the efficiency of 

data entry. Key combinations that use the Ctrl (or Command  for 
Macintosh), Shift, and forward slash (/) keys in conjunction with alpha 
characters can save time when you are entering large amounts of data. 

Since the Tab Key is recommended for moving from field to field, you 
can use the shortcuts to quickly complete a window and rarely use the 
mouse. 

Selection Lists 
When you tab out of a blank required field that has a selection list, the 
list will open automatically. If the selection list has an upper and lower 
pane, use Shift+Tab to toggle between the panes of the selection list 
and press the up or down arrow keys on the keyboard to make your 
selection. Press the Enter key, and the field is populated.  

Definitions 
The following terms are used throughout the documentation: 

tab out - press the Tab Key on the keyboard to move the cursor to 
the next field.  

fields with selection lists - fields that have an arrow  button at 
the right end of the field (usually referred to as the down 
arrow). This arrow indicates that a separate window can be 
opened to make selections and populate the field.  

required fields - fields that must be completed before you can 
save a record.  

Slash Key Uses 
The slash key can be used alone or in combination with alpha characters 
to open selection lists or populate other fields in the Work Order 
windows, Quick Post windows, and Biomed Equipment.  

Work Orders 
When entering work orders, you can use the forward slash key in 
various ways depending on the amount of information you have 
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available. For instance, if you have the Tag  # of an item, you can use it 
in a slash key combination to complete required fields. The topic titled 
New Work Order – All Fields Blank includes an example. 

You can also type the forward slash and tab out of non-required fields 
that have selection lists to open the selection list window. 

New Work Order – All Fields Blank 
IMPORTANT: The following technique works only if the Location ID, 
Building/Area and Tag# fields are empty when the shortcut is used.  

These steps apply to a work order written for an Equipment item that 
has a known tag number: 

1. Click the Add button on the TMA toolbar. 

2. Type /E followed by the Tag# in the Location ID field. 

3. Tab out of the field. 

When you tab out, the Location ID, Building, Area and Tag # fields are 
populated.  

Example: Type /EB-2365 to populate the required Location ID and 
related fields with information about a piece of equipment (E) with the 
tag # B-2365. 

The same procedure applies to any of the following items on a work 
order. Follow the steps outlined above and use the alpha character and 
tag # that apply to the item you want. 

/G – Groups 

/N - Entities 

/V - Vehicles 

/A - Assets (WorkGroup and Enterprise) 

/T - Tools (WorkGroup and Enterprise) 

Reminder: This technique works only if the Location ID, Building/Area 
and Tag# fields are empty when the shortcut is used. 

Work Order – Non-Required Fields 

If a down arrow  is present at the right end of a non-required field, 
type a slash and tab out of the field. This should open the selection list.  

Selection lists can always be opened by using the mouse to click the 
down arrow.  

Quick-Post Windows 
When you post work orders using the Quick Post function, use the slash 
+ character technique to limit the items on the selection list to those of 
a particular type. The following apply to:  

Quick-Post Time and Labor  

Quick-Post Material  

Quick-Post Other Charges 

Rather than typing the work order number in the Work Order field, you 
can use one of the shortcut entries (/R, /E, /G, /V, /A, /T) and tab out to 
open a selection list of work orders that show: 

Areas (/R) 
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Equipment (/E) 

Groups (/G) 

Vehicles (/V) 

Assets (/A) (WorkGroup and Enterprise only) 

Tools (/T) (WorkGroup and Enterprise only) 

Biomed Equipment 
Since the location hierarchy rules are different for biomed equipment, 
you can override the current location for a piece of biomed equipment 
by using the /B shortcut. This shortcut breaks the association with the 
previous location and uses the new location.  

The format is: [NewLocation]/B[TagNumber]  

Example:  

  New Location = B-100  

  Tag Number = JL2705 

  The shortcut is entered as: B-100/BJL2705 

This shortcut applies to biomed equipment only. 

Date Fields 
The slash key technique does not work with date fields, however, you 
can type the numeric day or day and month and tab out. TMA will 
format the entry and add the current year to the date. 

 Examples:  
If you type the number 9 and tab out of the field, the field will 
change to read: Current month/09/current year. 

or 

 If you type 1023 and tab out, the field will display 10/23/current 
year. 

Selection Windows Search 
If you want to search a character or character string in selection popup 
windows, these tips help expedite your efforts.  

Many selection windows are multi-paned. When the window opens, the 
focus is in the top pane. You can select a term in the first pane by typing 
the first character or characters. A line item is highlighted immediately.  

Once you have highlighted a line in the upper pane, press the Tab key to 
move the focus to the lower pane. You can type the initial characters 
again to search for an item, or you can search for a character within a 
string using the asterisk wild card (*). The wild card technique also 
works for popups in a single-pane list.  
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The following steps outline the process: 

1. Type a character in the upper pane to locate the desired line. 

2. Press the Tab key. 

3. Type an asterisk using Shift+8. 

4. Type the character or characters you seek. 

5. Use the plus (+) and minus (-) keys on the numeric keypad to 
move forward and backward through the list to view other line 
items that contain the character or characters you specified. 

Keyboard Combinations 
You can use key combinations to achieve the same results as point and 
click. These key combinations are available for the TMA toolbar, the 
menu bar, TMA function menus and several miscellaneous functions. 
Note: The same combinations apply to Macintosh users, but the 

combination uses the Command key (  ) rather than Ctrl, i.e., 
Command+A is used to add a record, etc.  

TMA Toolbar 
   Keys    Equivalent Mouse Click 

Ctrl+A TMA Add Record (Add button)* 

Ctrl+E TMA Edit mode (Edit button) 

Ctrl+D TMA Delete Current Record (in View mode) 

Ctrl+F TMA Find Record (Find button) 

Ctrl+N TMA Next Record (Next button) 

Ctrl+P TMA Previous Record (Prev button) 
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   Keys    Equivalent Mouse Click 

Ctrl+- Find First 

Ctrl++ Find Last 

Ctrl+R TMA Print (Print button) 

ESC TMA Cancel button 

Enter TMA OK button 

*Ctrl+A serves double duty (see File and Edit Menu Options next). 

File and Edit Menu Options 
      Keys    Equivalent Mouse Click 

Ctrl+Q (File) Exit TMA (File > Quit) 

Ctrl+Shift+L (File) Log off (File > Log off) 

Ctrl+A (Edit) Select All (in a particular field) 

Ctrl+C (Edit) Copy (selected data from a field) 

Ctrl+V (Edit) Paste (selected data to a field) 

Ctrl+X (Edit) Cut (selected data from a field) 

Ctrl+Z (Edit) Undo (before tabbing to next field) 

Delete key Clear selected text 

Miscellaneous 
    Keys    Equivalent Mouse Click 

Ctrl+Q Quit the application 

Ctrl+W Close Current Window 

Ctrl+TAB Next Tab window (Identity, etc.) - Studio 

Alt+C Comments window on Quick Post Time & Labor 

Ctrl+Shift+L Log off 

F1 Help 

F4 TotalView 

F6 Edit Bookmark 

F7 Spell check a field 

Shift+F7 Spell check a window 

Alt+F7 Spell Checker Options 

; Previous window - Classic 

, Next window - Classic 

Function Windows 
Keyboard equivalents using both Ctrl and Ctrl+Shift are used to open 
thirty-three TMA windows. To help you find the code, the information is 
organized in two ways. The following combinations are sorted by window 
name (in alphabetical order) and then by key combination. Note: The 
same combinations apply to Macintosh users, but the combination uses 

the Command key (  ) rather than Ctrl, i.e., Command+Shift+E is 
used to open a Building record, etc.  
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SORTED BY WINDOW NAME 
 

  Equivalent Mouse Click     Keys 

Area Records Ctrl+K 

Asset Records Ctrl+G 

Biomed Equipment Ctrl+U (TMA Client/Server) 

Buildings Records Ctrl+Shift+E 

Checks & Conditions Records Ctrl+Shift+J 

Contracts Ctrl+Shift+K 

Departments Records Ctrl+Shift+D 

Entity Records Ctrl+Y 

Equipment Records Ctrl+L 

Generate PMs Ctrl+Shift+G 

Hazardous Materials Records Ctrl+Shift+H 

Manufacturers Ctrl+Shift+N 

Materials Browse Crtl+Shift+S 

On-Hand Adjustment Records Ctrl+Shift+A 

Part Records Ctrl+I 

Personnel/Technician Records Ctrl+H 

Projects Records Ctrl+Shift+P 

Purchase Requisitions Records Ctrl+O 

Quick Post - Labor by Technician Ctrl+Shift+F 

Quick Post - Material Ctrl+Shift+M 

Quick Post - Other Ctrl+Shift+O 

Quick Post - Time & Labor Ctrl+Shift+T 

Receivings Ctrl+Shift+I 

Refrigerants Records Ctrl+Shift+Y 

Report Manager Ctrl+Shift+R 

Request Batch Validation Ctrl+Shift+U 

Request Browser Ctrl+Shift+B 

Sales Order Records Ctrl+S 

Scheduler  Ctrl+Shift+Q 

SQL Query Window Ctrl+1 

Task (Job) Library Ctrl+J 

Time & Attendance Ctrl+Shift+V 

Tools Records Ctrl+Shift+C 

Vehicles Records Ctrl+Shift+Z 

Vendors Ctrl+Shift+X 

Warehouse or Stockroom Ctrl+Shift+W 

Work Order Browse Ctrl+T 

Work Order Records Ctrl+M 
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SORTED BY KEY COMBINATION 
 

   Keys    Equivalent Mouse Click 

Ctrl+1 SQL Query Window 

Ctrl+G Asset Records 

Ctrl+H Personnel/Technician Records 

Ctrl+I Part Records 

Ctrl+J Task (Job) Library 

Ctrl+K Area Records 

Ctrl+L Equipment Records 

Ctrl+M Work Order Records 

Ctrl+O Purchase Requisitions Records 

Ctrl+S Sales Order Records 

Ctrl+T Work Order Browse 

Ctrl+U Biomed Equipment (TMA Client/Server) 

Ctrl+Y Entity Records 

Ctrl+Shift+A On-Hand Adjustment Records 

Ctrl+Shift+B Request Browser 

Ctrl+Shift+C Tools Records 

Ctrl+Shift+D Departments Records 

Ctrl+Shift+E Buildings Records 

Ctrl+Shift+F Quick Post – Labor by Technician 

Ctrl+Shift+G Generate PMs 

Ctrl+Shift+H Hazardous Materials Records 

Ctrl+Shift+I Receivings 

Ctrl+Shift+J Checks & Conditions Records 

Ctrl+Shift+K Contracts 

Ctrl+Shift+M Quick Post - Material 

Ctrl+Shift+N Manufacturers 

Ctrl+Shift+O Quick Post - Other 

Ctrl+Shift+P Projects Records 

Ctrl+Shift+Q Scheduler  

Ctrl+Shift+R Report Manager 

Ctrl+Shift+S Materials Browse 

Ctrl+Shift+T Quick Post - Time & Labor 

Ctrl+Shift+U Request Batch Validation 

Ctrl+Shift+V Time & Attendance 

Ctrl+Shift+W Warehouse or Stockroom 

Ctrl+Shift+X Vendors 

Ctrl+Shift+Y Refrigerants Records 

Ctrl+Shift+Z Vehicles Records 
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Glossary of Terms 

Add mode 
when the Add button on the TMA toolbar is clicked to create a new 
record in the TMA software, the software is said to be in Add mode. 
From the time the Add button is clicked until the OK button is clicked to 
save, the record is in Add mode. 

Area 
part of the location hierarchy nomenclature from TMA. The Area is the 
third and lowest hierarchy level, and work orders are written on this 
level.  

Browse 
a way to display a list of the records in a table format. Double-click a 
line in the browse table, and the software will open that record on the 
Identity Tab. 

Building 
the second level of the location hierarchy.  

Check box 
a square toggle field. Click to select (place a mark in the box), or click to 
deselect (clear). 

Command+click 
a technique used for selecting nonadjacent files for a Macintosh 
computer. Press and hold the Command (  ) key and click random lines 
to select (or deselect) lines. 

Ctrl+click 
a technique used for selecting non-adjacent files in MS Windows. Press 
and hold the Ctrl key and click random lines to select (or deselect) lines. 
A similar technique is Shift+click to select adjacent files. 
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Deselect 
a term meaning to clear a choice, frequently in check boxes or radio 
buttons. Check boxes and radio buttons operate on a toggle principle: 
click to select, and click once more to clear. 

Disabled 
when part or all of the display on a window is disabled, the print is light 
gray and does not respond when clicked. See Enabled. 

Drag-and-drop 
a standard procedure where text or a line item is selected. You place the 
cursor somewhere on the selection, and then you press and hold down 
the left mouse button. While continuing to hold the mouse button, move 
the cursor (drag) to a different location. When the mouse button is 
released, the selection is "dropped" in the new location. Frequently, the 

mouse displays as the universal stop symbol  until the correct 
destination is reached. This indicates that no action will be taken unless 
you 'drop' on the correct area of the window. 

Down arrow 
the button marked with a downward pointing arrow at the end of a field. 
When you click this button, it opens a selection window from which to 
choose data to add to the field. 

Edit mode 
when the Edit button on the TMA toolbar is clicked, the record on display 
is said to be in Edit mode. In this mode, changes to a record can be 
made and saved. You remain in Edit mode until the changes are saved 
(click OK on the TMA toolbar) or cancelled (click Cancel on the TMA 
toolbar). 

Enabled 
menu items and some buttons on a window can be enabled or disabled. 
When enabled, the print is dark and easily seen. This indicates that the 
menu option or function can be selected. When disabled, the print is 
light gray and does not respond when clicked. 

Enter key 
the key that is labeled "Enter" on most keyboards. It is also marked with 
an arrow  that points left.  

Enterprise 
the most robust version of TMA software. It is used with Oracle and SQL 
databases. 

Facility 
the highest level of the TMA location hierarchy. 
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Field 
an element of the TMA window used to store default settings from the 
software program or information entered by users. The type of 
information required for the field is identified by the field name. Field 
information can be numbers, text, time, date, Y/N, or name. 

Indexed fields 
refers to key identifiers in the data tables. Indexed fields can be 
recognized because the mouse pointer changes to an 'I' beam when 
positioned over an indexed field.  

Keyboard shortcuts 
a keyboard equivalent for most menu options so you can avoid using the 
mouse. Shortcuts consist of a combination of two or three keys pressed 
at the same time (usually the Control key plus others). For example, 
Ctrl+M opens the Work Order window, Ctrl+Shift+W opens the 
Warehouse window. 

Location hierarchy 
the area-based levels that are part of the core structure of TMA. The 
default levels, starting at the top, are Facility, Building and Area. 

Location ID 
a combination of a building code and an area number used throughout 
TMA to identify a space. 

Path 
a term used to describe the location of a file. Starting with the drive 
designation (C:, D:, etc.), the Path shows each directory (folder) and 
subdirectory separated by a backslash (\) and the name of the file. 
Example: C:\My Documents\Files\letter.doc  

PM 
an acronym meaning planned or preventive maintenance. Many items 
are scheduled for planned maintenance to avoid breakdowns at 
inconvenient times. 

Populate a field 
a term that indicates information is added to a field either manually or 
automatically. 

Radio button 
round toggle option buttons. A mark within the button indicates it is 
selected. Only one in a group of radio buttons can be selected.  

Record 
a record is a collection of fields stored in the database. 
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Repair Center 
the group/work center responsible for the maintenance of areas, 
equipment, assets and other items within TMA. Assigning a repair center 
allows TMA to segregate data by areas of responsibility. TMA users 
cannot view items linked to a repair center other than their own without 
Dispatcher or System Administrator access. 

Request date 
the date the work request was submitted or a work order was created. 

Required fields 
one or more fields on a window that must be completed in Add mode to 
create a valid record in the table. These show the minimum amount of 
information needed to create a record. 

Scheduled date 
the date a work order is assigned to a technician. 

Selection window 
a smaller window that is superimposed on the current window. Typically 
these windows pop up when a down arrow is clicked. Use these windows 
to refine the search criteria to find the data you want to add to a field. 

Shift+click 
similar to Ctrl+click except the lines selected are adjacent. For example, 
to select an entire list, click the first line item, press the shift key, and 
click the last line item to select all lines in between. 

Subtab pane 
the panes associated with folder-style Tabs at the bottom of a window 
that display additional information. As each Subtab is clicked, you can 
review the information on the Subtab panes.  

Subtab strip 
a series of folder-style Tabs at the bottom of a window that display 
additional information. These operate like the Tabs at the top of the 
window. Click each Subtab to review the information on the Subtab 
panes. 

Tab Key 
the Tab Key on the keyboard. This is the recommended navigation tool 
used to move from one field to the next in TMA. 

Tab out 
this term indicates that you press the Tab Key on the keyboard to move 
out of one field and into another. Using the Tab Key for cursor 
movement is the preferred navigation method when using TMA software. 
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Tab 
a window within a function that is identified by a folder-style Tab along 
the top of a window. The interface for each Tab can be viewed by 
clicking the labeled Tab. 

User 
in the TMA manuals, the term user refers to the person logged in to the 
TMA software. 

View mode 
when a saved record is displayed in the window, the record is in View 
mode. You can see the contents but cannot make changes to the record. 

WorkGroup 
a version of TMA with more features than TMA eXpress but fewer than 
TMA Enterprise.  

Zoom 
this term refers to a convenient right-click method of opening a related 
record. When you zoom to a record, the current window closes, and the 
related window opens. Typically, you can zoom back to the original 
record. 
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